Parkland College

A with Honors Projects Honors Program

2013

Some Dentrix and Dexis Basics to Help You with
Your Case Study

Amanda O'Connor
Parkland College

Recommended Citation

O'Connor, Amanda, "Some Dentrix and Dexis Basics to Help You with Your Case Study" (2013). A with Honors Projects. 94.
http://spark.parkland.edu/ah/94

Open access to this Article is brought to you by Parkland College's institutional repository, SPARK: Scholarship at Parkland. For more information,

please contact spark@parkland.edu.


http://spark.parkland.edu/
mailto:spark@parkland.edu

Some Dentrix and Dexis Basics to
Help You With Your Case Study!

Made for the Parkland College Dental
Hygiene Department






What is a “screenshot?”

* A screenshot is an image taken by
the computer user to record the visible items
displayed on the monitor.

e Let me take a screen shot of my current
computer screen to show you what | mean.



Below is a screenshot of the slide you just saw. The method of taking a screenshot can
vary from computer to computer, but it is usually accomplished by hitting the “print
screen” button on the keyboard. This button is often abbreviated to show the letters “prt
sc” and with some computers you must hit “contro

|”

of another button first.
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Once you have taken the screenshot, you can either hit the “paste” button under the
home tab at the top of the PowerPoint window, or you can simply hit “ctrl” + “v” on the
keyboard. The screenshot will then be inserted, and it will be large. See the screenshot
below to see what | mean. You will notice that when inserted, the screenshot covered
the entire slide. You must size it down by selecting it, grabbing a corner, and dragging it
towards the center of the picture. SCREENSHOT
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Once you have taken the screenshot, you can either hit the “paste” button under the
home tab at the top of the powerpoint window, or you can simply hit “ctrl” + “v” on the
keyboard. The screenshot will then be instered, and it will be large. See the screenshot
below to see what | mean.
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Below is a sized-down screenshot of a previous slide. You will notice that everything |
could see on my computer monitor is visible in the screenshot, including the task bar at
the bottom, and all of the PowerPoint options. Perhaps | don’t want you to see all of the
extra stuff. Perhaps | just want you to see the slide. In that case, we will crop the
screenshot.
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In order to crop the screenshot, you must first insert the screenshot as before. Once it is
inserted into the powerpoint, you will select it. Once you have selected it, go to the
“Format” tab at the top of the screen, and select crop. You will then see little black
handles in spots around the screenshot. Click and move those to crop sections off of the

image.

Black handles for cropping

e items

1t
nean.




Once you crop your screenshot to show only what you want, you will have something like
this.

What is a “screenshot?”

* Ascreenshotis animage taken by
the computer user to record the visible items
displayed on the monitor.

* Let me take a screen shot of my current
computer screen to show you what | mean.




SCREENSHOTS

The circled screenshots have
been captured, pasted, and
then cropped in order to
appear as they do here.
Please note that each entire
picture on this slide is also a
screenshot.
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When to use a screenshot

Inserting the patient’s teeth and perio charts into the
powerpoint (previous slide)

If using the Dentrix comparison charts to show
changes in probing status (see below)

Showing the Dentrix treatment plan (see below)
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When NOT to use a screenshot

e Taking patient photos (from intra-oral camera)
from Dentrix/Dexis

* Taking x-rays from Dentrix/Dexis

* |f you use screenshots to put these into
Powerpoint, they will come out blurry due to
the fact that you will have to enlarge them so
much after cropping. There is a better way to
put these items into a PowerPoint.



EXPORTING




What is “exporting?”

* Exporting is generally converting a file from its
current form to another, and often saving it to
another location.

e Exporting images (both x-rays and intra-oral
photgraphs) from Dentrix/Dexis allows you to
save the picture as a file to the computer.
From there, you can insert it into your
PowerPoint like you would any other picture.
The picture will be large, clear, and not require

cropping.
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Once you click the export button, a box will come up. There are three
buttons you want to click BEFORE you choose to export the images. You
want to click “Desktop” at the top to export the pictures to the Desktop.
Click “Export All” to include all of the images. Click “JPEG (.JPG)” to export
the files in JPEG format. Once you have selected these options, click
“Export Images” at the bottom of the box.
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The images will now appear on the computers Desktop. The icon looks
like the x-ray image.
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You can now copy them directly from the Desktop where you see them, or
from the actual folder. To go to the folder, click the start button, and then
click “Computer.”
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Navigate to the Desktop folder. It can often be found as one of the shortcuts on the left-
hand side of the box. Click on “Desktop” to go into the folder. Once in the folder, you can
copy the pictures to put them on a flash drive, insert them into a PowerPoint or Word
document, email them, etc.

I E

RecycleBin  Publisher

T |
®

Organize v System properties  Uninstall or change a program ~ Map network drive  Open Control Panel

4757 Favorites 4 Hard Disk Drives (2)
B Desktop Windows (C) ThawSpaced (T}

1 Downloads w [ | [P |
198 GB free of 232 GB w 991 MB free of 099 GB

1| Recent Places

4 Devices with Removable Storage (1)
4[4 Libraries

s 4
» [ Documents &\@ DVD RW Drive (09
b @) Music -

b & Pictures 4 Network Location (5)
» B Videos . SYSONEAGLE) (H) _ previser (\hpr) (P} _ dentrx (\hpi) R)

:’/ 122 GBfree of 175 GB \:‘/ 153 GB free of 199 GB <&@, 153GBfreeof 199 GB

418 Computer
» & Windows (C) . dexis (\hpr) (X) _ PUBLIC (\EAGLE\SYS) (Z)

0 G2 SYS (\EAGLE) (H) 3/ 153 GB free of 199 GB :‘V 122 GB free of 175 GB
[1+] prew%ev (\\hpr) (P:) 4 Other (1)

b &2 dentrix (\\hpr) (R:)

b (5 ThawSpaced (T:) ZENworks Adaptive Agent

63 deds (\hpr) (%) System Folder

b &8 PUBLIC (\EAGLE\SY

» € Network

I | L149-WS-HPR-20 Domain: campus.parkland.edu ~ Memory: 400 GB
o Processor: Intel(R) Core(TM) i5-35...

) s o gy 1156AM [
€voH mIw 12721083



Remember, you can also just highlight the images on the Desktop screen and copy them

as well.
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In order to insert the images to your existing PowerPoint from a flashdrive or other folder
on your computer, follow these steps. Go in to the PowerPoint presentation, and go to
the “insert tab” at the top. Click “Picture,” and a file window will come up. Navigate to
the file folder where the images were saved (could be the desktop if this is the computer
on which you exported the images). At this point, you should see the images like in the
screenshot below. Select the one(s) you want to insert and click “insert” at the bottom of
the box. You can now crop, re-size, and otherwise edit the picture to the way you want.
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Look at the images below. The one on the left was inserted as a screenshot, and cropped
down to size. The one on the right was exported properly and inserted from an image
file. They are both acceptable looking. The export used ClearVu which helps us see more
detail, and it can also be enlarged without becoming too blurry. The quality difference is
more apparent when working with images from the intra-oral camera, so it is highly
recommended that you export those. Also, even though both of these images look okay,
keep in mind that the one which was exported did not have to be cropped, saving a big
step.
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To make an “Exam Comparison,” go into the perio chart. Go to “view” at the top, and
then select “Exam Comparison.”
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A box will appear, and from that you can check boxes for exams you want to include.
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The comparison chart will appear. In order for it to appear as it does below, make sure
that “Clinical Attachment Level — Graphic” is selected from the drop down box.
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All of the colors used in the comparison chart can be changed. Click on the “Perio
Display...” button in the bottom left corner of the chart. A box will pop up. Click on the
“Exam Comparison Colors” tab. You will now have the option to change all of the colors
used to make your chart more readable, or to make it match your PowerPoint

presentation theme.
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You can make a different kind of comparison by simply selecting a different option from
the previously shown dropdown box. This option is the “Probing Depths — Data” option.
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If you need to open a previous perio exam simply to see the probe reading, go to “File” at
the top of the Perio window, and select “Open Exam.”
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If you only need the most recent exam, it is already displayed when you open the Perio
window. However, if this most recent exam was not just performed, the numbers will be
faded looking rather than bright like they were when the readings were recorded. If you
go to “Open Exam” and select the exam date, it will make the readings bright again.
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What is an exam you want to include in your presentation is not on the computer? If you
have perio exam information for a patient that is charted on paper, you can input the
information into the computer chart in order to include it. Go to the Perio window, go to
“File” at the top, and select “New Exam” from the drop down options.
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A calendar box will pop up. Use the arrows to select the date that the exam was
performed (make sure you are in the correct year).
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Another good and quick visualization you can utilize is made by simple clicking one button
in the Perio window. Click the “Graphic Chart” button on the toolbar. If you are having
trouble telling which button is the correct one, hover the mouse over a button and it will
tell you which button it is.

View Setup Help

Eile

HENp e NPl ¢h [ Script | Dentic Default Seript I8
i g -
{ Perio o X
Databnty |
3 34 3 4 2 3|3 23/322[3223|223 2 2 2 3/312/323[323(424/4325 Ferio Navigation
2 1 1 1 1 1 1 1 Current:  2- FIDIPD
3 3|4 5 4|5 3/!3 23332333233 3 2 3332233 3/323424/4325 O [vec 2rom
YOS [ Prev: 31-LDIPD I
-- - - --------i--------- - --i- - - - - Resume: 2 - FIDIPD
Tooth Information
Tosth#2-Facisl | Facialilingual || Arch ][ Home |
' Dli(a\ c M(;s\a\
_ _ I [ I R I I _ P32 ][ 3] (7)(8) (9
el L1~
3233233 22(222222/223/323323333|333 cef3 2z [3]
ol 0 1 (@)@
3 313 2 3|3 2 2|2 22|22 2|22 3|323/323|33 3333 (=8 e ] o | |
M M Bld D D D L Q&
. D D D 1 (3 (Del
Mobility: 0 £1 C2 3 C4
M ? M Plaque: & None " Light (" Moderste (" Heavy
1 2 2 2 3[2 1 5 3 55 3 4 Bore Loss: & Nore " Mild " Moderste (" Severe
1 2 2 2
2 3(4 3 4(43 4|42 32222 42|2 3123 2|222/223|3 23 435|535 534
File View 5S5etup Help :
- _—
3 “'—l o = i 3 |_|
O 1 ép L_-j L - !

F; # ﬂ. E -'1'“:- @




Here is an example of the chart that will be displayed if you use the “Graphic Chart”
button. Note: You can also get this by going to the “View” tab and selecting “Graphic
Chart.”




At the bottom of the box in which the graphic chart is displayed, you can select “Show
Options” and then choose various things to include (furcations, bleeding, CAL level, etc.)
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There is also an “Exam Comparison” button which will allow you to produce the
previously shown comparisons (as opposed to going through the “View” tab at the top.
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MAKING &
TREATMENT PLAN




Making a treatment plan is a great thing to do because it shows our patients an estimate
of how much they would have to pay for the work we are giving them if they were to go
to a normal practice (assuming they do not have insurance). This helps them appreciate
the services we offer, even if appointments are long and deep scalings aren’t fun. To

begin, click the “Treatment Plan” button at the top of the main dental chart window.
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Use the “Procedure Codes” box on
the right side of the screen to
select the procedures you wish to
include in the treatment plan.
Once you select a procedure (or
multiple procedures at once), click
the tooth with the checkmark to
add them to the plan.
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Once all of the codes you want have been added, go to the “Options” tab at the top, and
select “Treatment Planner.”
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This is what you will see. The codes you selected should be shown.
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In order to print an appealing, patient-friendly version of the treatment plan, go to “File,”
“Print,” and then click “Print Treatment Case.”
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This box will come up. Itis very important to go through the options and select or
deselect the appropriate ones. Check the “Print Preview” box at the bottom so that you
can review it before printing. This will allow you to make sure no information is included

that shouldn’t be. ¢
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Once you click “OK,” the print preview will come up. If you are satisfied, click print and
give it to your patient. Also, if you are doing this for a case study and have a moment,

take this opportunity to take a screenshot of the treatment plan and save it for your
presentation.
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GOOD LUCK WITH
YOUR CASE
STUDY?




EXAMPLE SLIDES
FROM A CASE
STUDY




Charting
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Savin’ Money!
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Massive Improvement!

® @ ®) 9 9 d

DCM DCM DCM MCD MCD MCD
st







	Parkland College
	2013
	Some Dentrix and Dexis Basics to Help You with Your Case Study
	Amanda O'Connor
	Recommended Citation


	Some PowerPoint Basics to Help You With Your Case Study!

